Oracle ® Applications
User’s,
System Administrator’s, and Flexfields
Documentation Updates

RELEASE 11.0.1

June, 1998

ORACLE
Enabling the Information Age™
Copyright © 1998, Oracle Corporation. All rights reserved.

The Programs (which include both the software and documentation) contain proprietary information of Oracle Corporation; they are provided under a license agreement containing restrictions on use and disclosure and are also protected by copyright, patent and other intellectual and industrial property laws. Reverse engineering, disassembly or decompilation of the Programs is prohibited.

The information contained in this document is subject to change without notice. If you find any problems in the documentation, please report them to us in writing. Oracle Corporation does not warrant that this document is error-free. Except as may be expressly permitted in your license agreement for these Programs, no part of these Programs may be reproduced or transmitted in any form or by any means, electronic or mechanical, for any purpose, without the express written permission of Oracle Corporation.

If the Programs are delivered to the US Government or anyone licensing or using the Programs on behalf of the US Government, the following notice is applicable:

Restricted Rights Notice
Programs delivered subject to the DOD FAR Supplement are ‘commercial computer software’ and use, duplication and disclosure of the Programs including documentation, shall be subject to the licensing restrictions set forth in the applicable Oracle license agreement. Otherwise, Programs delivered subject to the Federal Acquisition Regulations are ‘restricted computer software’ and use, duplication and disclosure of the Programs shall be subject to the restrictions in FAR 52.227–19, Commercial Computer Software — Restricted Rights (June 1987). Oracle Corporation, 500 Oracle Parkway, Redwood City, CA 94065.

The Programs are not intended for use in any nuclear, aviation, mass transit, medical, or other inherently dangerous applications. It shall be licensee’s responsibility to take all appropriate fail-safe, back-up, redundancy and other measures to ensure the safe use of such applications if the Programs are used for such purposes, and Oracle disclaims liability for any damages caused by such use of the Programs.

Oracle is a registered trademark, and Oracle Workflow are trademarks of Oracle Corporation. All other company or product names mentioned are used for identification purposes only, and may be trademarks of their respective owners.
Oracle Applications User’s, System Administrator’s, and Flexfields Documentation Update

This section contains important information. Please read this section for the latest updates and additions to your Applications User’s, System Administrator’s, and Flexfields guides.

This section contains updates for the following topics:

- Profile Options in Oracle Applications Object Library
- Using the Requests Window
- Customizing the Presentation of Data in a Folder
- Export
- Shortcut Keys for Buttons
- Uploading/Downloading Attachment Files
- Viewing Reports in HTML
- Administering Oracle Applications Security in Release 11
- Administering Server Security
- Using the Navigator’s Processes Region
- Assigning an Account Generator Process to a Flexfield Structure
- Administering the TCF SocketServer
- Hierarchy Screen
- The Graphical Navigator
  - Modifying your menu
  - Creating/Customizing Graphical Navigator Processes (Overview)
  - Creating Graphical Navigator Processes
  - Modifying Graphical Navigator Processes

Profile Options in Oracle Applications Object Library

The following Profile Options have been updated, created, or obsoleted:

- RRA:URL
- Concurrent: Show Requests Summary After Each Request Submission
• Viewer: Default Font Size
• Viewer: Text
• Message Level Threshold
• RRA: Service Prefix
• TCF: Host
• TCF: Port

See: Profile Options in Oracle Applications Object Library *Oracle Applications System Administrator’s Guide:*

**RRA:URL**

The profile option RRA:URL is obsolete. This profile option provided a URL which enabled the Report Review Agent to display reports in a browser. Applications now uses the URL entered for the profile option Applications Web Agent instead.

**Concurrent: Show Requests Summary After Each Request Submission**

Using this new profile option, you can choose to either have the Requests Summary displayed each time you submit a request, or retain the request submission screen.

The default is “Yes”. “Yes” means the Requests Summary screen is displayed each time you submit a request.

If you choose “No”, a decision window is opened asking you if you wish to submit another request. When you choose to submit another request you are returned to the submission window and the window is not cleared, allowing you to easily submit copies of the same request with minor changes.

Users can see and update this profile option.

This profile option is visible and updatable at all four levels.

<table>
<thead>
<tr>
<th>Level</th>
<th>Visible</th>
<th>Allow Update</th>
</tr>
</thead>
<tbody>
<tr>
<td>Site</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Application</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Responsibility</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>User</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

The internal name for this profile option is CONC_REQ_SUMMARY.
Viewer: Default Font Size

Using this new profile option, you can set the default font size used when you display report output in the Report Viewer.

The valid values for this option are 6, 8, 10, 12, and 14.

Users can see and update this profile option.

This profile option is visible and updatable at all four levels.

<table>
<thead>
<tr>
<th>Level</th>
<th>Visible</th>
<th>Allow Update</th>
</tr>
</thead>
<tbody>
<tr>
<td>Site</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Application</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Responsibility</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>User</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

The internal name for this profile option is FNDCPVWR_FONT_SIZE.

Viewer: Text

The Viewer: Text profile option has been enhanced to allow you to send report output directly to a browser window. Enter “Browser” in this profile option to take advantage of this new feature.

See: Profile Options in Oracle Applications Object Library, Oracle Applications System Administrator’s Guide

Message Level Threshold

The Viewer: Text profile option has been enhanced to allow you to send report output directly to a browser window. Enter “Browser” in this profile option to take advantage of this new feature.

The valid values for this option are 6, 8, 10, 12, and 14.

Users can see and update this profile option.

This profile option is visible and updatable at all four levels.

<table>
<thead>
<tr>
<th>Level</th>
<th>Visible</th>
<th>Allow Update</th>
</tr>
</thead>
<tbody>
<tr>
<td>Site</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Application</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Responsibility</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>User</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

The internal name for this profile option is FND:MESSAGE_LEVEL._THRESHOLD
RRA: Service Prefix

Using this new profile option allows you to override the default service name prefix (FNDFS_) assigned to the Report Review Agent. By assigning a new prefix to the Report Review Agent you can avoid having multiple instances of the Applications share executables.

Valid values for this option must be nine characters or less and use only alphanumeric characters or the underscore. We recommend using the underscore character as the last character of your value as in the default value “FNDFS_”.

Users cannot see or update this profile option.

This profile option is visible and updatable at the site level only.

<table>
<thead>
<tr>
<th>Level</th>
<th>Visible</th>
<th>Allow Update</th>
</tr>
</thead>
<tbody>
<tr>
<td>Site</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Application</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Responsibility</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>User</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>

The internal name for this profile option is FS_SVC_PREFIX.

⚠️ Attention: GLDI will not support the “RRA: Service Prefix” profile until release 4.0 and so uses the default prefix “FNDFS_” regardless of the value entered for the profile option. Consequently, you must ensure that at least one of your Report Review Agents maintains the default prefix in order for GLDI to access the application executables.

TCF: HOST

Using this profile option with the TCF: PORT option allows selected product forms to interact with Java applets which provide graphical display of hierarchical data.

Set the value of this profile option to the hostname of the machine running SocketServer.

Initially you should set these profile options at the site level to ensure that all Applications use them. As more products make use of this listener, you may choose to start multiple SocketServers and set these profile option values at the Application level. This will route users of different applications to different instances of the SocketServer.

Users cannot update this profile option.

This profile option is visible at all levels and updatable at the site and application level only.
The internal name for this profile option is TCF:HOST

See: Administering the TCF SocketServer

TCF: PORT

Using this profile option with the TCF: HOST option allows selected product forms to interact with Java applets which provide graphical display of hierarchical data.

Set the value of this profile option to the port number of the machine running SocketServer.

Initially you should set these profile options at the site level to ensure that all Applications use them. As more products make use of this listener, you may choose to start multiple SocketServers and set these profile option values at the Application level. This will route users of different applications to different instances of the SocketServer.

Users cannot see or update this profile option.

This profile option is visible and updatable at the site and application level only.

The internal name for this profile option is TCF:PORT

See: Administering the TCF SocketServer

Using the Requests Window

When running Applications on the Web, choosing Copy File from the Special menu in the Request’s window displays the selected requests output in a browser window. From the browser window, you can use the native browser tools to save your request output to a file.

See: Using the Requests Window: Oracle Applications User’s Guide
Customizing the Presentation of Data in a Folder

With the addition of multi-language support, Folders are associated with specific languages. Existing folders are associated with the base language of the Site and new folders are associated with the language used when the folder is created. Folders can only be accessed when the Applications are running in the same language that is associated with the folder. For example, a folder created in the French version of the Applications cannot be accessed when running the Applications in German.

See: Customizing the Presentation of Data in a Folder: Oracle Applications User's Guide

Export

Use the Export feature to export records in a multi-row block to the application of your choice. Export always uses the records and format currently queried in the form. Thus, you can control the data to be exported using the query functions of the form, such as Query Find. Additionally, if you are exporting from a Folder form, you can reorder columns in the form or remove unwanted columns before you export.

To start the export process:
1. Query the records you want to export.
   
   Note: To reduce the time required to export your records, reduce the number of records returned by using explicit query criteria.

2. Make sure that your cursor is in the Multi-row block that contains the records to be exported.

3. If you are exporting information from a Folder form, you can use the folder tools to reorder columns, select which columns to display, and customize column prompts. These customizations will be maintained when you export the data.

4. Choose Export... from the Action menu.

Select an Application:
5. If you or your System Administrator have not set up a default application that recognizes the export output format, you will be prompted by your Browser to select one. For example; if you are using Netscape 3.0, it displays an “Unknown File Type” window. In this window, choose the Pick App... button which provides you
with a list of applications to choose from. If you select Microsoft Excel, your information is displayed in an Excel spreadsheet. Any application that is capable of interpreting tab–delimited files will be able to display the output.

Example of Setting up a Default Application for Export

You can set up your Browser environment so that exported data is automatically displayed in the application you specify. Each Browser type setup is unique; this example explains the steps required to set up Microsoft Excel as the default application for Export within Netscape Communicator 4.0:

1. Open Netscape Communicator 4.0.
2. Within Netscape select Edit > Preferences from the menu.
3. In the Preferences window, select Navigator > Applications.
4. Choose the New Type button.
5. Use the following table to determine the values to enter in the New Types window.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Value Entered</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description of Type</td>
<td>Tab–Delimited</td>
</tr>
<tr>
<td>File extension</td>
<td>exp</td>
</tr>
<tr>
<td>MIME type</td>
<td>text/tab–separated–values</td>
</tr>
<tr>
<td>Application to use</td>
<td>c:\MSOffice\Excel\Excel.EXE &quot;%1&quot;</td>
</tr>
</tbody>
</table>

Note: To Set up your browser you must enter the MIME type exactly as shown in the table. The Application field should be set to reflect the location of the application you wish to use. The Description and File extension fields are optional.

6. Choose OK.

Exporting Large Numbers of Records

Export automatically selects all records currently retrieved, as well as the remaining records associated with the current query. If the records retrieved exceed 100, you will be prompted to:

Stop

Limits the records available to be exported to those already selected by the export process. You will then be prompted to either cancel the export, or export only those records already selected. The number of records selected is included in the decision window.
Allow the export process to select all records retrieved in the form. When all records retrieved have been selected the export process will automatically export the records.

**Note:** We recommend that you do not use the export feature for very large numbers of records, such as numbers that exceed 1000, as this is time consuming, and uses significant machine and network resources.

**Continue** Will select the next 100 records. When all records retrieved have been selected the export process will automatically export the records. Otherwise, you will continue to be prompted until all records are selected or you choose Stop or Continue to End.

**Shortcut Keys for Buttons**

Most window buttons are mapped to keyboard shortcuts. The shortcut key is indicated with an underline in the button label. For example, in the Request Summary window, the button label **Hold Requests** has the “H” underlined. This indicates that you can use the keyboard shortcut Alt–H to put a request on hold instead of using the mouse.

**Note:** The keyboard shortcuts for buttons are defined in the English version of the Applications and do not change when the applications are translated. Although these shortcuts are active for all languages the shortcuts may not be indicated in the translated button label. Using the example from above, in the French version of the applications, the Hold Requests button is labeled “Bloquer le traitement”, but the shortcut key is still Alt–H.

**Uploading/Downloading Attachment Files**

**To attach an existing file to an Oracle Applications record:**

1. In an application window, query or enter a data record.
2. Choose the Attachment toolbar icon. The Attachments window opens.
3. Use the List of Values to choose a Category.
4. Optionally enter a Description.
5. Use the List of Values to choose a Data Type.
6. Use the Tab key to open the Upload window in a separate browser window.
7. You can either enter path for the file you want to attach or use the
   Browse button to choose a file.
8. Choose OK and follow the instructions in the Browser window.

9. Click on Yes in the Decision window.
To open an uploaded attachment:
Choose the Open Document ... button
See: Adding an Attachment: Oracle Applications User’s Guide

Viewing Reports in HTML

In Release 11, reports that produce an output other than a text file (for example HTML or PDF) are displayed in a browser. If you set the profile option VIEWER: TEXT to Browser, your text files are also displayed in a browser as opposed to the Report Viewer.

Administering Oracle Applications Security in Release 11

In Release 11 the security model has been enhanced to include login authentication for web access as well as ensuring secure web access to files used by such features as Export and Attachments. This enhancement requires a newly created .dbc file, a Database Access Descriptor setup at install, and that you provide a URL for the profile option Applications Web Agent.

See Also

Profile Options in Oracle Applications Object: Library Oracle Applications System Administrator’s Guide

Administering .dbc Files

The .dbc file is contained on the web/applications server and holds information used by the database for authentication. The
web/application server passes the information from the .dbc file, as well as login information, to the database server to authenticate the user. The authentication process is handled by the standard applications security feature.

The .dbc files required by the application server security system are not part of the delivered product and must be created after installation.

The Java script **AdminAppServer** is used to create the .dbc files.

Prior to running AdminAppServer you must ensure that:

- JDBC classes are in the CLASSPATH and LD_LIBRARY_PATH
- $JAVA_TOP is in the classpath

The syntax for the script begins with the call to the script.

```
jre oracle.apps.fnd.security.AdminAppServer [parameters]
```

The first parameter must be the connection string followed by the command string.

```
apps/apps@dbname
ADD
```

Some commands require additional parameter(s). For example, the ADD command must be followed by the GWYUID and FNDNAM parameters, which are followed by any optional parameters. Optional parameters are indicated in brackets.

```
jre oracle.apps.fnd.security.AdminAppServer apps/apps@dbname \  
ADD \  
GWYUID=pub/pub FNDNAM=apps \  
[SERVER_ADDRESS=<tcp.ip address>] \  
[SERVER_DESCRIPTION=<machine_name>] \  
[<env_name>=<env_value>] \  
SECURE_PATH=$FND_TOP/secure \  
GUEST_USER_PWD=<username/password>
```

In the example above, the parameter env_name allows you to enter additional information you wish to store in the .dbc file. Programs that access the Applications using the .dbc file will use all of the environment variable settings in the file. Additionally, if you do not provide a value for the SERVER_ADDRESS it will default to the ip address of the machine on which the utility is run.

**Creating .dbc Files**

Use the AdminAppServer script to create a .dbc file for the application server to access the database server. In addition to creating the .dbc file this script registers the application server with the database for the Applications Server Security feature.
To access additional database servers from the same application server, you must rerun the AdminAppServer script for each additional database. You must run the AdminAppServer script each time you create a .dbc file, and each .dbc file only allows access to one database.

To create a .dbc file for an application server:

1. You must set the username/password value for the GUEST_USER_PWD parameter. Create a valid username ("visitor" for example) in Oracle Applications. Then use the username/password combination as the value for GUEST_USER_PWD. The syntax is illustrated in the following example:

   GUEST_USER_PWD=visitor/welcome

   Oracle recommends that you do not assign any responsibilities for this user.

2. From the command line, enter:

   jre oracle.apps.fnd.security.AdminAppServer apps/apps@dbname \
   ADD \
   GowyID=pub/pub FNDNAM=apps \
   [SERVER_ADDRESS=<tcp.ip address>] \
   [SERVER_DESCRIPTION="Public web access server"] \
   [<env_name>=<env_value>] \
   SECURE_PATH=$FND_TOP/secure \
   GUEST_USER_PWD=<username/password>

   The SECURE_PATH parameter provides the location of the directory which contains .dbc files. The value of this parameter must be set to $FND_TOP/secure.

Updating or Deleting a .dbc File

When updating the .dbc file you can change as many parameters as you want, including the server ID, but you must enter at least one. Settings that you do not update retain their value.

To update a .dbc file:

   From the command line, enter:

   jre oracle.apps.fnd.security.AdminAppServer apps/apps@dbname \
   UPDATE \
   [SERVER_ID] \
   [SERVER_ADDRESS=<tcp.ip address>] \
   [SERVER_DESCRIPTION="Public web access server"] \
   [<env_name>=<env_value>]

   [env_name]
SECURE_PATH=$FND_TOP/secure
GUEST_USER_PWD=<username/password>

**Attention:** If you have not already set the username/password value for the GUEST_USER_PWD parameter, you can do so here using the UPDATE command. For instructions, see the section on Creating DBC files in .Administering Oracle Applications Security in Release 11.

**To delete a .dbc file:**

- From the command line, enter:
  
  ```
  jre oracle.apps.fnd.security.AdminAppServer apps/apps@dbname 
  DELETE 
  SERVER_ADDRESS=<tcp.ip address> 
  SECURE_PATH=$FND_TOP/secure
  ```

  This deletes the .dbc file and disallows access to the indicated database if Server Security is active.

**Administering Server Security**

Because Release 11 is deployed in a multi-tier configuration, the security model has been enhanced to include authentication of application servers to the database servers they access. When this layer of security is activated, it uses “server IDs” or passwords that the application server passes to the database server. If the database server recognizes the server ID, it grants access to the database. The server IDs are created using a Java utility.

The application server security system is not initially activated. You must activate it after installation. The application servers are registered with the database and assigned server IDs when you create .dbc files for Oracle Applications Security in Release 11.

The Java script AdminAppServer is used to set up, activate, and check the status of the application server security feature. For a detailed description of the AdminAppServer utility see Administering Oracle Applications Security in Release 11.

**Server ID Status**

You can check the Server ID status for a particular database using the STATUS command in the AdminAppServer script. The STATUS command displays all registered application servers and their server IDs. The command also indicates whether the server security feature is currently active.
Attention: Check the server ID status of your databases before you activate server security and ensure that all desired Application Servers have been registered.

To check the server ID status for a database:
- From the command line, enter:
  
  ```
  jre oracle.apps.fnd.security.AdminAppServer apps/apps@dbname \ STATUS
  ```

Activation of Server Security

You can turn the server security feature on or off using the same AdminAppServer utility. When you turn off server security, you will not change or delete your server IDs. You can restart server security without recreating server IDs for all of your applications servers.

To activate server security:
- From the command line, enter:
  
  ```
  jre oracle.apps.fnd.security.AdminAppServer apps/apps@dbname \ AUTHENTICATION ON
  ```

To deactivate server security:
- From the command line, enter:
  
  ```
  jre oracle.apps.fnd.security.AdminAppServer apps/apps@dbname \ AUTHENTICATION OFF
  ```

Updating or Deleting Server IDs

You can update or delete a application server’s server ID at any time. When updating the server ID you can change as many parameters as you want, including the server ID, but you must enter at least one.

Note: Server ID values are generated by the AdminAppsServer utility, and therefore cannot be supplied on the command line.

To update a server ID:
- From the command line, enter:
  
  ```
  jre oracle.apps.fnd.security.AdminAppServer apps/apps@dbname \ UPDATE \ SERVER_ID \ [SERVER_ADDRESS=<tcp.ip address>]
  ```
Attention: If you have not already set the username/password value for the GUEST_USER_PWD parameter, you can do so here using the UPDATE command. For instructions, see the section on Creating DBC files in .Administering Oracle Applications Security in Release 11.

To delete a server ID:

Server IDs can be deleted by deleting the corresponding .dbc file. This must be done using the AdminAppsServer utility as explained in the Updating or Deleting a .dbc File section.

Using the Navigator’s Processes Region

The Processes region of the Navigator, enables you to navigate to forms associated with a specific business functionality within Oracle Applications. These processes are listed on the left portion of the screen. Several generic process are delivered with the applications, however, your System Administrator can modify these processes or create new processes to meet your specific needs.

Working with a Process

The available processes are displayed on the left side of the Navigator window.

1. Select a process by clicking on its title in the list
   The Navigator displays a flow of the process and a process description beneath it.

2. Click once on any icon within the processes to display a brief description of that step.

3. Double-click on an icon to open the related Oracle Application form.
   The Navigator continues to display current process until you select another process enabling you to return to the Navigator at any time to open additional forms in the process.

Attention: Function Security is enabled through the Processes region of the Navigator. If your current responsibility does not have access to the form, you will receive an error message.
Assigning an Account Generator Process for a Flexfield Structure

Within the Account Generator Processes window, you select a flexfield structure by using a Row–LOV from Query > Find..

Administering the TCF SocketServer

Beginning with Oracle Applications 11.0.1, selected product forms will support interactions with Java applets which provide graphical display of hierarchical data. The Thin Client Framework (TCF) provides the Java applets a means of communicating with the Application Server and Database Server tiers. When an applet is launched by a form, it is told the hostname and port where it can find the TCF listener process called SocketServer which provides this connection.

Setting up the SocketServer

To use the SocketServer the System Administrator must start the TCF SocketServer process and provide values for the profile options TCF:HOST and TCF:PORT.

1. **Starting the SocketServer**
   1. Select a port on the Application Server where the Developer/2000 Server is running.
   2. Enter the following at the command prompt:
      ```
      jre oracle.apps.fnd.tcf.SocketServer <port number> [-d]
      ```

      The optional –d parameter creates a window which displays a list of active connections handled by the SocketServer process.

      **Attention:** Be sure that the CLASSPATH environment variable includes your $JAVA_TOP directory and the JDBC support classes. You must also ensure that the LD_LIBRARY_PATH environment variable includes the Oracle 8.0.4 JDBC driver libraries. These variables should normally be included in an environment script used when starting the Oracle Web Server 3.0.1. If these variables are not set properly, the TCF SocketServer may not be able to support client connections.

2. **Setting the Profile Options**
   1. Login using the ‘System Administrator’ responsibility
   2. Navigate to the System Profiles Values window.
   3. Use the Find window to locate the profile options TCF:Host and TCF:Port by entering:
in the Profile field.

**Note:** The values for these profiles should be initially set at the Site level to ensure that all Applications see these values. You can override these values later by entering values at the Applications level. This routes the users of different applications to different instances of the SocketServer.

4. Enter the hostname of the machine running SocketServer, and the port number you chose for it.

5. Save your changes.

**Hierarchy Screen**

The Hierarchy Screen contains an Object Navigator that allows you to navigate through your flow data. The following describes the elements of the Menu Structure and Toolbar Structure.

### Menu Structure

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>File</strong></td>
<td></td>
</tr>
<tr>
<td>Exit</td>
<td>Exits from the Object Navigator.</td>
</tr>
<tr>
<td>Print ...</td>
<td>Prints the current hierarchy to a printer</td>
</tr>
<tr>
<td><strong>Edit</strong></td>
<td></td>
</tr>
<tr>
<td>Preferences</td>
<td>Allows the user to set default color, font, and icon settings for all nodes displayed within the Object Navigator. (Refer to Sample Screen – Preferences for more details)</td>
</tr>
<tr>
<td>Type Display</td>
<td>Allows the user to assign color and icons to a specific type of node. (Refer to Sample Screen – Type Display for more details)</td>
</tr>
<tr>
<td><strong>View</strong></td>
<td></td>
</tr>
<tr>
<td>Horizontal</td>
<td>Displays hierarchy in an Organization Chart style. The parent node will start in the middle of the screen. Child nodes will branch out from under the parent in a root like fashion.</td>
</tr>
<tr>
<td>Vertical</td>
<td>Displays hierarchy in a Microsoft Windows Explorer style. The parent node will start from the upper left corner of the screen. Child nodes will be displayed below the parent and slightly indented to the right.</td>
</tr>
<tr>
<td>Column</td>
<td>Displays hierarchy in a hybrid style of Horizontal and Vertical. The parent node will start in the upper left corner of the screen. Child nodes will be displayed in a column to the right of the parent node.</td>
</tr>
<tr>
<td>--------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Toolbar</td>
<td>Allows the user to display or hide the toolbar.</td>
</tr>
<tr>
<td>Node Type</td>
<td>Allows the user to display or hide the type of node information for all nodes in the Hierarchy pane.</td>
</tr>
<tr>
<td>Help</td>
<td></td>
</tr>
<tr>
<td>Using Object Navigator</td>
<td>Allows the user to view html help on the Object Navigator. The first help could be a “table of contents” type page that gives the users an overview of all the help topics available for the Object Navigator.</td>
</tr>
<tr>
<td>Selected Node Descriptions</td>
<td>Allows the user to view node information for any selected node.</td>
</tr>
<tr>
<td>Debug Information</td>
<td>Allows the users to turn debug information on or off. Currently, Object Navigator supports debugging the values returned by the akquery engine. These values are displayed on a screen. Similar support will be provided by the new Object Navigator.</td>
</tr>
<tr>
<td>About Object Navigator ...</td>
<td>Allows the user to view the current version number of the Object Navigator as well as other miscellaneous information.</td>
</tr>
</tbody>
</table>

**Toolbar Structure**

![Toolbar Structure](image.png)

Prints the current hierarchy

![Prints the current hierarchy](image.png)

Allows the user to display nodes in a vertical Microsoft Windows Explorer style. The parent node will start from the upper left corner of the screen. Child nodes will be displayed below the parent and slightly indented to the right.
Allows the user to display nodes in a horizontal Organization Chart style. The parent node will start in the middle of the screen. Child nodes will branch out from under the parent in a root like fashion.

Allows the user to display nodes in a hybrid style of Horizontal and Vertical. The parent node will start in the upper left corner of the screen. Child nodes will be displayed in a column to the right of the parent node.

The Graphical Navigator

The Graphical Navigator is ready to use when you install production Release 11.0.1. The Graphical Navigator includes seeded processes and provides:

- Descriptions about each process as a whole
- Descriptions about the individual steps in each process
- Direct access to the form associated with each step in a process

Note: To access some of the forms related to the seeded processes, you may need to make some modifications to your responsibility.

Seeded Processes

With production Release 11.0.1, the Graphical Navigator comes seeded with high level processes that span the expense cycle, the revenue cycle, and the cash reconciliation process. You can use these processes as they are, modify these processes, and create new processes that are specific to your particular organization. Each process seeded with release 11.0.1 is described below:
Expense Cycle Process

**Expense Cycle Process Diagram**

Below is the seeded Expense Cycle Process. It spans entering a requisition to inquiring about the transaction in the General Ledger. This process covers only expense and asset requisitions.

The following diagram depicts the purchasing process for Vision Operations.
Revenue Cycle Process

Revenue Cycle Process Diagram

Below is the seeded Revenue Cycle Process. It spans entering a sales order to inquiring the transaction in the General Ledger. This process does not represent all functionality available in the revenue cycle.

The following diagram depicts the sales order process for Vision Operations.
Cash Cycle Process

**Cash Cycle Process Diagram**

Below is the seeded Cash Cycle Process. It spans reconciling and forecasting cash to inquiring about the transaction in the General Ledger. This process does not represent all functionality available in the cash cycle.

The following diagram depicts the forecasting process for Vision Operations.
Modifying Your Menu

Simply referencing a form from a process does not provide the required permissions for the responsibility to access the forms in the process. Form Functions for each form referenced from a process must be added to the Function Security Menu for the responsibility. If the Form Function is not accessible, the user will receive an error when attempting to access the form from the process in the Graphical Navigator.

See: Form Functions Window

See: Menus Window

Creating/Customizing Graphical Navigator Processes

You must use Oracle Workflow Builder to create or customize any of the processes that are displayed in the Graphical Navigator. These instructions describe how to create new or modify existing graphical processes for the Graphical Navigator.

The following table lists the terms/components of a Graphical Navigator process and the corresponding components in Oracle Workflow Builder that define them.

<table>
<thead>
<tr>
<th>Graphical Navigator Component</th>
<th>Description</th>
<th>Controlling Oracle Workflow Builder Component(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process</td>
<td>The diagram that appears in the Graphical Navigator.</td>
<td>Process activity and process diagram</td>
</tr>
<tr>
<td>Process description</td>
<td>A description of the displayed process.</td>
<td>Process activity</td>
</tr>
<tr>
<td>Step</td>
<td>An icon in the process, which takes you directly to an Oracle Applications form when you double-click on it.</td>
<td>Notification activity</td>
</tr>
<tr>
<td>Step description</td>
<td>A description of the selected process step.</td>
<td>Message</td>
</tr>
<tr>
<td>Form associated with a step</td>
<td>The Oracle Applications form that appears when you double click on a step in a Graphical Navigator process.</td>
<td>Message attribute</td>
</tr>
</tbody>
</table>

Table 1 (Page 1 of 1)

Note: The following procedures do not address most of the functionality of Oracle Workflow Builder, but are tailored to creating or modifying processes for the Graphical Navigator. The Oracle Workflow Builder is a tool used to design workflow processes. Workflow processes can range from routing...
documents through an approval process to setting up your Oracle Applications. See: Oracle Workflow.

See: Creating Graphical Navigator Processes: page – 24
See: Modifying Graphical Navigator Processes: page – 31

Creating Graphical Navigator Processes

To create a new process for the Graphical Navigator, you must first create the necessary components in Oracle Workflow Builder. The components you create make up the process definition, which is then saved to the database or to a flat file. The Graphical Navigator then reads the process definition from the database to display the process and its information and provide you access to the related Oracle Applications forms.

► Creating a New Graphical Navigator Process

1. Open Oracle Workflow Builder.
2. Create an item type—a component that will contain all the components associated with the process you wish to build.
3. Create messages.
4. Create Open Form message attributes.
5. Create notification activities.
6. Create a process activity.
7. Draw the process diagram.
8. Save your changes.
9. Enable access to your process

Create an Item Type

An item type is a classification of the components that contain a process or processes. An item type is a repository of attributes, messages, notifications, and processes which are all required to build your new Graphical Navigator process. Often times it makes sense to define an item type so that it describes the item being managed by your process. For example, “Closing Processes” can be an item type while “Year-End”, “Month-End”, and “Period-End” can be processes associated to the “Closing Processes” item type.

► Creating an Item Type

1. Run Oracle Workflow Builder and create a new data store by selecting New from the File menu.
A data store allows you to save your item types to a flat file until you are ready to save the processes to the database.

2. Define a new item type in the navigator tree by choosing New Item Type from the Edit menu. An Item Type property page appears.

3. Every item type has an all–uppercase internal name, which is a maximum of eight characters long.

   **Attention:** You cannot update the internal name for an item type once it is defined.

   **Caution:** Do not include colons “:” or spaces in your internal name.

4. The translatable Display Name should be longer and more descriptive. This value does not appear in the Graphical Navigator, but appears when you load or maintain your item types in the database using Oracle Workflow Builder.

5. Choose OK.

6. A secondary branch appears in the navigator tree that represents the item type you just created. You can review or edit the properties of this item type at any time by double–clicking on the item type in the navigator tree or by selecting the item type and choosing Properties from the Edit menu.

### Create Messages

Create a message to describe the task that is to be accomplished by a Graphical Navigator process step.

The easiest way to create a new message is to make a duplicate of an existing message and modify the duplicate as described in the instructions below. Alternatively, you can select the item type you want to create a message for, and choose New Message from the Edit menu. See: To Create a Message.

#### Creating or Modifying a Message

1. Access a seeded process from the database using Oracle Workflow Builder if you have not already done so.

2. Expand the item type branch of the seeded process, then expand its corresponding Messages branch.

3. If you wish to create a new message, select an existing message that has an Open Form message attribute associated with it. You can check this by selecting an expandable message and expanding the message to list its message attributes.
4. If you wish to copy the message to a different item type, make sure you first expand that item type’s branch.

5. Drag and drop the message you have selected to the Messages branch associated with the item type for which you are creating the message.

6. A message property page now appears, prompting you to update the information in the fields that must be unique. Enter a new unique internal name for the new message. The internal name must be in all uppercase with no spaces or colons “:”. The internal name can not be updated once it is defined.

7. Enter a new display name for the message using the format <Verb><Form Title>. If the form title already contains a verb, then simply use the form title as the display name. If the form title does not contain a verb, then consider using one of the following verbs:

   Define / Assign / Run / Load / Convert / Open / Set / Generate / Review

8. Choose the Body tab and update the Subject field to match the display name you just entered.

9. Enter text in the Body field such that the text describes to the Graphical Navigator user the task they should accomplish with the referenced form.

10. Choose OK to apply your changes and close the property page.

Create Open Form Message Attributes

Create an Open Form message attribute for a message to provide a link to an Oracle Applications form from a Graphical Navigator process step.

If you create a new message by copying an existing message, then you automatically copy its Open Form message attribute(s) along with it. Alternatively, you can create a new Open Form message attribute by dragging and dropping an existing Open Form message attribute to a new message. Following the instructions below to modify the Open Form message attribute.

► Creating or Modifying an Open Form Message Attribute

1. Double–click on the Open Form message attribute you wish to edit.

2. In the Default Value region, make sure the left–hand field is set to Constant. In the right–hand field, enter form function name of the form that you want your Graphical Navigator process step to access. See: Finding the Form Function Name: page – 34.
Create Notification Activities

Create a notification activity to represent a Graphical Navigator process step.

**Creating or Modifying a Notification Activity.**

1. Select the message that describes the Graphical Navigator process step you wish to create.

2. Drag and drop the message to the Notifications branch of the same item type. A new notification activity property page appears which now references the message.
   - If you wish to edit an existing notification activity, expand the Notifications branch of the item type you wish to edit.
   - Double-click on the notification activity you wish to edit.

3. Enter an all uppercase internal name for the notification. You can use the same internal name that you used for the message.
   - **Attention:** You cannot update the internal name of an activity once it is defined.
   - **Caution:** Do not include colons “:” or spaces in your internal name.

4. Enter or modify the display name so that it is identical to the display name of the message that this notification references. The display name is translatable and appears in your process diagram.

5. Enter or modify the description for the notification.

6. Update the message field if necessary to reference the appropriate message. If this is a new notification activity you are creating, then the message reference should already be set to the appropriate message.

7. Choose an icon that identifies your activity. You can use any icon, as long as the icon is stored in a .ico file. Choose Browse to view the icon files listed in the Oracle Workflow icons subdirectory. You can also drag and drop icon files from the Windows Explorer or File Manager onto an activity in the Oracle Workflow Builder navigator tree to assign that icon to the activity. See: Adding Custom Icons to Oracle Workflow.
   - **Note:** If you wish to use your own specialized icon not shipped with the Oracle Workflow, you must load the specialized icon in the following directory on your web server:

   ```
   <java_directory_tree>/oracle/apps/fnd/wf/icons
   ```

   `<java_directory_tree>` represents the java directory tree that you map to the `/OA_JAVA/` virtual directory in Oracle Web Application Server when you install Oracle Applications.
8. Choose OK to save your changes and close the property page.

Create a Process Activity

Create a process activity to represent a Graphical Navigator process.

A process activity represents the collection of activities in a process and their relationship to one another. Once you create the process activity in Oracle Workflow Builder, you can draw the process diagram.

To Create or Modify a Process Activity

1. Select the item type that you want to create a process activity for, and choose New Process from the Edit menu. A property page appears for you to define the process activity.

   Alternatively, to modify an existing process activity, expand the Process branch of the item type that the process belongs to. Select the process activity you wish to edit and choose Properties from the Edit menu.

2. Enter a unique all uppercase internal name to identify your process.

   Attention: You cannot update the internal name of an activity once it is defined.

   Caution: Do not include colons ":" or spaces in your internal name.

3. Enter a display name for your process. This name appears in the Graphical Navigator’s process list. The naming convention for the process should be a functional name followed by the word “Process”.

4. Enter a description for your process. The description appears when a user selects a process in the Graphical Navigator. For Oracle Workflow Builder Release 2.0.3, the description is limited to 240 characters.

5. Choose OK to save your changes and close the property page.

Draw a Process Diagram

Once you create a process activity, you can draw the process diagram that is associated with it. The process diagram is what appears when you display a process in the Graphical Navigator.

To Create or Modify a Process Diagram

1. Double-click on the process activity to open it's Process window.
2. Drag and drop notification activities from the Oracle Workflow Builder navigator tree to the Process window. The notification activities represent the steps in your process.

3. Load roles from the database. See: Roles.

4. For each notification activity that you drag into the Process window, double-click on the activity to display its process node property page. Set the Performer Type to Role, and choose any role in the right hand field.

   **Note:** The Graphical Navigator ignores the Performer setting, however, Oracle Workflow Builder will flag as an error, any notification activity in a process that is not assigned a performer because in a real workflow process, a notification must be assigned to a performer.

5. To draw a transition arrow between two notifications, select a notification and while holding down your right mouse button, drag the mouse to another notification and release. See: To Create and Edit a Transition.

6. In the Process window, double-click on a notification you wish to designate as the start of your process. Set the Start/End field to Start. Choose OK to save your changes and close the property page.

7. In the Process window, double-click on a notification you wish to designate as the end of your process. Set the Start/End field to End. Choose OK to save your changes and close the property page.

**Save Your Changes**

All processes are associated with an item type. An item type can include one or more processes. You can save item types to a database or to a flat file. When you save your work to a database, you actually save everything in the current data store that has been modified. When you save your work to a flat file, you actually save everything in the current data store to the file.

You can also load an item type into Oracle Workflow Builder from a database or flat file. Opening an item type automatically retrieves all the attributes, messages, lookups, notifications, functions and processes associated with that item type. See: Opening and Saving Item Types.

**Attention:** It is highly recommended that for new processes created for the Graphical Navigator that you always save a copy of your workflow process definition as a flat file and check that file into a source control system to maintain a
working version of your process definition. Then when you want to update your definition in the database, you can pull up the flat file and save it directly to the database. Avoid using the process definition stored in your database as your source controlled version, as others with access to the database can update the definition.

Enable access to your process

Before a process may be accessed in the Navigator you must complete the following two steps. Create a new function for your process in the Form Functions window, and add your process to a responsibility by adding the function you just created, to the responsibilities top menu in the Menus window.

► Create a function for your Process

1. As the System Administrator navigate to the Form Functions window (Application–>Function).
2. Enter a Function Name for your process using the format:
   
   <app>_<processname>
   
   Where <app> can be any application short name and <processname> is the internal name you entered when you created your process activity.
3. Enter a User Function Name. The name you enter here appears in the Navigator.
4. Enter “PROCESS” as your function type.
5. In the alternative region ‘Form’ use the following format to enter a value in the Parameters field:
   
   <itemtype>:<processname>
   
6. Save your work. No other fields are required to create your process function.

See: Form Functions Window

► Add your function to a menu

In order for a user to access a process in the Navigator, the process must be added to a menu referenced by the users responsibility. To determine the menu referenced by a particular responsibility use the Responsibilities window (Security–>Responsibility–>Define).

1. As the System Administrator navigate to the Menus window (Application–>Menu).
2. Use the Find window to access the desired menu.

3. In a new row use the LOV to select the function you created for your process in the Functions field. You may optionally enter a description for the function. DO NOT enter any other fields. The Sequence field is automatically populated and the Navigator Prompt and Submenu fields must remain empty.

4. Save your work.

See: Menus Window

Modifying Graphical Navigator Processes

For production Release 11.0.1 of Oracle Applications, three processes are available for immediate use. These processes are:

- Expense Cycle Process
- Revenue Cycle Process
- Cash Forecasting Process

These processes provide a high level view of how a company enters a sales order to receiving cash as well as how a company enters a requisition to paying its invoice. You should add steps to these processes or change portions of the processes to accommodate your business needs. You can perform the following modifications to your process:

- Add new steps
- Delete existing steps
- Change a process’ name and description
- Change the icon, name and description of a process step
- Change the form link to a step

Access the Seeded Processes from the Database

To access the seed processes from the database, you need to first installed Oracle Applications production Release 11.0.1 and you need to install Oracle Workflow Builder Release 2.0.3 or greater on your client PC.

To access the seed processes

1. Run the Oracle Workflow Builder from your client.
2. Select Open from the File menu.
3. Choose Database.
   • For User, enter the FNDNAM of your database
   • For Password, enter the FNDNAM password of your database
   • For Connect, enter the alias for your database which should be entered in your tnsnames.ora file under the following directory on your client:

   Local drive (i.e. “C”):orant\network\admin

   **Note:** If you are using Windows 95, then the “orant” should be replaced with “orawin” in the directory structure above.

4. In the Show Item Types window, select the item type(s) associated with the seeded processes you wish to view. To select more than one item type, hold down your control key as you select the item types. Choose Show, and then choose OK.

**Adding a New Step**

1. Access the process from the database using Oracle Workflow Builder.
2. Create a message.
3. Create an Open Form message attribute.
4. Create a notification activity.
5. Add the notification activity to the process diagram.
6. Save your changes.

**Deleting an Existing Step**

To delete an existing step from a Graphical Navigator process, do the following:

1. Access the process from the database using Oracle Workflow Builder.
2. In the navigator tree of Oracle Workflow Builder, expand the Process branch and double-click on the process activity that represents the Graphical Navigator process you wish to edit.
3. In the process window that appears, select the activity that represents the step you wish to delete, then choose Delete Selection from the Edit menu.
4. Holding down your right mouse button, draw a new transition arrow between the activities that preceded and proceeded the activity you just deleted.
Note: Although it is not necessary, you may also wish to delete the notification activity, message and message attribute associated with the step you just deleted. To do so, expand the Messages and Notifications branches of the Oracle Workflow Builder navigator tree. First, find the notification activity for the deleted step in the Notifications branch and double-click on it to display its property page. Make note of the Message name displayed in its property page. Close the property page and choose Delete from the Edit menu to delete the notification activity. Now select the message referenced by the notification activity you just deleted and choose Delete from the Edit menu.

5. Save your changes.

► Changing a Seeded Process’ Name and Description


► Changing the Icon, Name, and Description of a Graphical Navigator Process Step

1. Access the process from the database using Oracle Workflow Builder.

2. Expand the Notifications branch in the navigator tree. Double-click the notification activity that represents the step you wish to modify.

3. To change the icon for the process step, see: Create Notification Activities: page – 27.

4. Make note of the message name displayed in the Message field of the notification activity property page. Choose OK to save your changes and close the property page.

5. Expand the Messages branch in the navigator tree. Double-click on the message referenced in the notification activity property page you just closed.

6. In the Display Name field, enter the new name that you want the Graphical Navigator process step to have.

7. Click on the “Body” tab of the message property page and in the Body field, modify the description of the step.

8. Save your changes.

► Changing the Form Link to a Step

1. Access the process from the database using Oracle Workflow Builder.
2. Expand the Notifications branch in the navigator tree and double-click on the notification activity that represents the step you wish to edit. Make note of the Message name listed in the property page, then choose Cancel.

3. Expand the Message branch in the navigator tree and locate the message that you just made a note of. Expand this message to display its message attribute(s).

4. Double click on the Open Form message attribute.

5. In the Default Value region, make sure Constant is selected in the left-hand field. In the right-hand field, enter in all capital letters, the form function name of the form you want your Graphical Navigator process step to access. See: Finding the Form Function Name: page – 34.

6. Save your changes.

Finding the Form Function Name

1. Log on into Oracle Applications and navigate to the form of interest.

2. Choose About Oracle Applications... from the Help menu. Scroll down to Form Information and make note of the form name.

3. Now log into Oracle Applications using the Implementation System Administration responsibility and navigate to /Application/Form. Within the Form window, query for the form name you just made a note of in the Form field.

4. Make note of the value in the User Form Name field once your query completes.

5. Close the Form window and navigate to /Application/Function. Within the Function window, query for the User Form Name value that you just made a note of in the Form field.

6. The value that is returned in the Function field is the form function name that you need to associate a Graphical Navigator process step to a form.
Setting up Web Report Review (UNIX)

In Release 11, reports that produce output other than a text file (for example, HTML or PDF) are displayed in a browser. Text files, such as log or report output files, can also be displayed in a browser. To implement this feature, you must set the “Applications Web Agent” profile option. This feature also relies on several steps that are part of the normal installation. If the Web Report Review feature is not functioning after you have set the “Applications Web Agent” profile option, use the included checklist to ensure that all of the required installation steps were completed successfully.

Set the “Applications Web Agent” profile option

The profile option "Applications Web Agent" must be set to the base URL of the APPS schema’s Web Application Server DAD (Database Access Descriptor).

    e.g. http://<WebAppServer_Machine_Name:Port>/<DAD_name>

Web Report Review Troubleshooting Checklist

Use this checklist to ensure that all of the steps required to enable Web Report Review have been completed. All of the steps contained in this list are part of the normal installation and implementation of Oracle Applications Release 11, but may not be required unless you are using Web Report Review functionality.

Set up and configure the Report Review Agent

(Use the Set Up the Report Review Agent section of the Oracle Applications Installation, Release 11 July 1998 Part # A57983-02)

Remember that your Net8 client machine is the Release 11 forms server. You should now be able to view log and report output files from the desktop client using the Report File Viewer.

Configure the AppletViewer

(from the Additional Configuration Steps section of the Oracle Applications Installation Release Notes, Release 11 July 1998 Part # A57981-03)

The AppletViewer must be configured such that it can launch a browser when necessary. Find the following line in your initial HTML file:

    <!PARAM name="ClientBrowser" value="<netscape>">

Remove the exclamation point (!) from the beginning of the line, and change the setting for the value parameter to the browser executable you will be using. For example, on a desktop client running Windows, you might change this line to read:

    <PARAM name="ClientBrowser" value="netscape.exe">

Be sure the program listed for the value parameter is in the PATH on the desktop client machine.

This configuration requires that all desktop clients that access this HTML file use the same browser executable to view help and web page attachments, as well as log and report output files.
Install the Oracle Applications certificate
(Use the Client Software section of the Oracle Applications Installation Release Notes, Release 11 July 1998 Part # A57981-03)

The Web Report Review feature cannot be used without the correct certificate on the desktop client. Install the OraApps.cer file on each desktop client that will be used to connect to Oracle Applications by running the appscert.bat file.

Set the browser path
(from the Client Software section of the Oracle Applications Installation Release Notes, Release 11 July 1998 Part # A57981-03)

The browser you specified in the HTML file earlier to view context-sensitive help and web page attachments as well as log and report output files must be on each client path before you start the AppletViewer. Verify that the client path includes the directory that contains this browser executable.

Verify that the PATH is set correctly by typing just the name of the browser executable at a MS-DOS command prompt; for example, "netscape" or "iexplore". If the PATH is correct, the browser will be started.

Configure virtual directories
(Use the Configure the Web Server section of the Oracle Applications Installation, Release 11 July 1998 Part # A57983-02)

The virtual directory /OA_HTML/bin/ must be of the type “CN”, and it must point to the physical directory $OA_HTML/bin.

Set up a DAD for the APPS schema
(Use the Configure the Web Server section of the Oracle Applications Installation, Release 11 July 1998 Part # A57983-02)

Follow the instructions in step 9, “Create an Oracle Web Application Server Database Access Descriptor (DAD)” in Chapter 4 of Oracle Applications Installation, Release 11 for UNIX.

Ensure that FNDWRR.exe exists in $OA_HTML/bin

The FNDWRR.exe file exists in $FND_TOP/bin by default. In order for Web Report Review to work, this executable must also exist in $OA_HTML/bin.

If FNDWRR.exe does not exist in $OA_HTML/bin, use the AD Administration utility (adadmin) to create it. Choose the “Relink Applications programs” option in the Maintain Applications Files menu. When prompted for the list of products to relink, enter “fnd”. Once adadmin finishes relinking fnd, FNDWRR.exe should exist in $OA_HTML/bin.

Start the web listener in an Applications environment

Your web listener must be started in an Applications environment to allow CGI programs access to Applications environment variables.

To start the listener in an Applications environment, log in to your web server as the owner of the Oracle Web Application Server files, source the Applications environment file located in the APPL_TOP directory, and start the web listener manually with the command:

owsctl start <listener name>
Set the "Viewer: Text" profile option

Set the profile option "Viewer: Text" to "browser" to view regular text report and log files in a web browser by default. If this profile option is left blank, the Report File Viewer will be used instead.

If the "Viewer: Text" profile option is left blank, a report or log file can still be viewed in a browser by first viewing it using the Report File Viewer, and then choosing "Copy File..." from the "Special" menu.

PostScript, HTML, and PDF files are always viewed in a browser, no matter what the “Viewer: PostScript”, “Viewer: HTML”, or “Viewer: PDF” profile options are set to. You must set up the appropriate helper applications in your browser in order to be able to view PostScript or PDF files.
Building Online Help for Custom Applications

There are three main ways to provide custom online help for your application:

- Customize Oracle Applications help files (not recommended because it will be overwritten upon upgrading or patching, and it could damage the Oracle Applications help)
- Customize custom help files provided by Oracle Applications (recommended for adding custom help to augment existing Oracle Applications help for particular Oracle Applications products)
- Build a custom help system for your application (recommended if you have built completely custom forms or have customized copies of Oracle Applications forms)

For information on customizing the custom help files provided by Oracle Applications, see the Oracle Applications System Administrator’s Guide. The following sections cover building a custom help system for your custom forms.

How the Help System Works

The Oracle Applications context-sensitive online help system for Release 11 provides context-sensitive help at a window-level granularity (that is, different help for each window in the application) and for individual Standard Request Submission reports and programs. Here is how the context-sensitivity works:

- The user presses the Window Help button or selects Help→Window from the menu.
- Oracle Applications constructs a target name for the window based on:
  - the name of the form (such as POXACCWO)
  - the name of the window (such as HEADERS)
- Oracle Applications searches for a help link file based on:
  - the directory path specified in the profile option HELP_BASE_URL (set when Oracle Applications help is installed; HELP_BASE_URL is an environment variable in Release 10.7 NCA)
  - the current language
Prepare Your Forms

Verify that your custom forms refer to your custom application short name in the FND_STANDARD.FORM_INFO routine in the PRE-FORM trigger:

FND_STANDARD.FORM_INFO('Revision: <Number>',
  '<Form Name>',
  '<Application Shortname>',
  'Date: <YY/MM/DD HH24:MI:SS>',
  'Author: <developer name>

If you leave the Application Shortname value as FND, your user will not see any help, because Oracle Applications will not be able to construct a valid help target.

Create Help Directory

You must create a subdirectory for your help files using your application short name as the subdirectory name. The subdirectory should be located under the online help directory for Oracle Applications. This is the directory path specified in the profile option HELP_BASE_URL (set when Oracle Applications help is installed). The exact location depends on your installation configuration.

Under your help subdirectory, you must also create another subdirectory called links. The links subdirectory holds the link files.

- the application short name specified in the FND_STANDARD.FORM_INFO routine in the form
- the links subdirectory
- a filename matching the name of the form

The link file provides the correspondence between the target (such as POXACCW0_HEADERS) and the target in the destination HTML file (such as rcvacc07.htm#POXACCW0.headers), and redirects the browser to open that destination file at the specified target.
Create HTML Help Files

Create your online help HTML files using your favorite HTML editor. Your help files can contain any links and information you want. To allow them to be called from your custom forms, you must include HTML target tags of the form near the beginning of the file:

```html
<A NAME="form_name.window_name"></A>
```

For example, your help file might contain the target:

```html
<A NAME="poxaccwo.headers"></A>
```

You can also create context-sensitive help for your Standard Request Submission reports and programs (and include targets for them in your HTML files). You include tags for your reports using the following syntax:

```html
<A NAME="srs.report_shortname"></A>
```

For example, your help file might contain the target:

```html
<A NAME="srs.poxacrcr"></A>
```

**Suggestion:** Both file names (on some platforms) and HTML target names are case sensitive, so you must ensure that the case of the HTML targets you specify in your help files matches the case you specify in the links files. To make this easier, we suggest that your help file names and target names are always lowercase (because Oracle Applications help and links files are automatically generated, the case of our targets and links match automatically).

If you want your help to have the same look and feel as Oracle Applications help, you can copy the contents of one of the custom help directories (such as the pocust subdirectory on the Unix platform). The custom help directories contain stub files for custom help (such as pocust.htm) as well as button graphics files and other files. Place the copies in your application’s help directory and modify the copies as appropriate. Be sure to modify any filenames, directory paths, links and targets embedded in the .htm files to fit your own application. For example, the Contents button in the pocust.htm file points to the help contents file for Oracle Purchasing.

Note that you do not need either the registry.txt or the ctxtsens.txt files that you might see in an Oracle Applications help directory; these files are byproducts of the process Oracle Applications uses to generate our HTML help system.
We recommend that you have approximately one HTML help file for every window or report in your application; however, this is not required, and you can organize your HTML files however you want.

Place your help files in the subdirectory that is named after your application short name (that is, not in the links subdirectory).

Create Help Links Files

To allow Oracle Applications to find the correct help file for your form when the user chooses the window help button from the toolbar, you must set up links files for your context-sensitive help. The links files store the correspondence between the target and the help file that contains the target. You must have one links file for each form, and the file must be named after the form (for example, poxaccwo.htm for the POXACCWO form). The links file contains link correspondences for all the windows in the form.

You should copy a links file from the Oracle Applications help and modify your copy (recommended because only the actual correspondence lines need to be modified, but the rest of the file is JavaScript code that is exactly the same for every links file). Here is an example links file (poxaccwo.htm). The link lines that you should modify are shown in bold (note that the variable names are uppercase):

```html
<HTML><BODY>
<SCRIPT LANGUAGE='JavaScript'>
function onerror(msg, URL, lineNum) {
    var newloc = '../notfound.htm?' + queryString
    location.replace(newloc)
    return true
}

var POXACCWO_HEADERS = 'rcvacc07.htm#poxaccwo.headers'
var POXACCWO_LINES = 'rcvacc07.htm#poxaccwo.lines'
var POXACCWO_QUERY_FIND = 'rcvacc07.htm#poxaccwo.query_find'

var queryString =
location.href.substring(location.href.indexOf('?')+1,location.href.length)
var newloc = '../' + eval(queryString)
location.replace(newloc)
```
You can also create context-sensitive help for your Standard Request Submission reports and programs (and include targets for them in your HTML files). You must create a separate links file for your reports and call that file srs.htm. You then list correspondences for all of your SRS reports in that file, as shown in the following example:

```html
<html><body>
<script language='JavaScript'>
function onerror(msg, URL, lineNum) {
    var newloc = '../notfound.htm?' + queryString
    location.replace(newloc)
    return true
}

var SRS_POASLUPG = 'athb03.htm#srs.poaslugp'
var SRS_POCFH = 'cthh07.htm#srs.pocfh'
var SRS_POCISO = 'cthh03.htm#srs.pociso'
...
var SRS_POCISO = 'cthh03.htm#srs.pociso'

var queryString = location.href.substring(location.href.indexOf('?')+1,location.href.length)
var newloc = '../' + eval(queryString)
location.replace(newloc)

</script>
</body></html>
```

**Modify Library File**

You may want to add a link to your custom application help in the Oracle Applications online help library file (library.htm). Note that this file will be overwritten upon upgrade (or possibly upon patching) and you will need to add your link again after upgrading, so save a copy of your modifications for future reference.
Upgrades and Patches

Because installation of the Oracle Applications help system is a simple installation of the entire directory and file structure for Oracle Applications help, your custom help directories will be overwritten upon upgrading or patching of the online help. Before upgrading or patching, you should be sure to preserve a copy of your custom help directory structures in a safe place before the upgrade or patch so you can move them back into position after your upgrade or patch.

Attention: The help system mechanism is subject to change for Release 12 or later, and you may need to revise your help system when you upgrade.
Generic Data Loader

The Generic Data Loader (FNDXLOAD) is a concurrent program that can move Oracle Applications seed data between database and text file representations. The loader reads a configuration file to determine what data to access. For information on specific configuration files consult the Open Interfaces Guide for your product group. The following sections describe the operation of the Generic Data Loader.

Attention: It is strongly recommended that you only use the SQL*Plus scripts provided. If you use scripts not provided by Oracle Applications or modify the provided scripts you risk corrupting your database.

Supported Operations

The generic loader can download data from an application entity into a portable, editable text file (*.ldt). This file can then be uploaded into any other database to copy the data. Conversion between database store and file format is specified by a configuration file (*.lct) that is read by the loader. The flow of information looks like this:

Usage

The Generic Loader takes the following arguments:

FNDXLOAD <username/password> 0 Y
  UPLOAD | DOWNLOAD <config_file> <data_file>
  <entity> [ <parameters> ]

where

<username/password>  is the APPLSYS account
<config_file>      is the configuration file
is the file that will be read or written

identifies the entity to upload or download

is a list of optional parameters of the form
NAME=VALUE. Parameters vary for each
configuration file. Review the documentation for
your configuration file for a list of parameters that
can be set.

File Specifications
The file specifications can have one of two forms

@<application_short_name>:<[dir]/.../]file.ext

or

<native path>

When calling the loader from a patch driver, you must use the '@' style
spec.
For example:

@fnd:patch/107/loader/fndapp.lct
@po:install/data/poreq.ldt

When testing the loader from a local directory, you can use the native
path.
For example:

mydata.ldt
c:\loader\config\cfg102.lct

Examples
FNDXLOAD apps/apps@devdb 0 Y
DOWNLOAD testcfg.lct out.ldt FND_APPLICATION_TL
APPSNAME=FND

connects to apps/apps@devdb
downloads data using config file testcfg.lct into data file out.ldt
downloads from the FND_APPLICATION_TL entity
loaders

with APPSNAME parameter defined to value ‘FND’

FNDXLOAD apps/apps@custdb 0 Y
  UPLOAD @FND:patch/107/loader/fndapp.lct
  @FND:patch/107/loader/fnd1234.ldt

connects to apps/apps@custdb
uploads data
using config file in $FND_TOP/patch/107/loader/fndapp.lct
from data file in $FND_TOP/patch/107/loader/fnd1234.ldt

Configuration File

Operation of the generic loader is controlled by the specified configuration file. The configuration file contains the following information for each entity:

- DEFINE block
- DOWNLOAD statement
- UPLOAD statement

The DEFINE block specifies the structure of the data file records. The define block format is identical to that already generated by existing Oracle Applications loaders.

The DOWNLOAD statement is a SQL statement that selects rows to download. The statement can and should join to other tables to resolve sequence generated ID numbers into developer keys where possible. The DOWNLOAD statement may also contain tokens of the form ‘&NAME’ which are substituted with values specified in the parameters section of the executable command line.

The UPLOAD statement is a SQL statement or PL/SQL anonymous block which has named BIND parameters that match the attribute names in the DEFINE section. During upload, the binds are match by name to values read from the data file. The statement is responsible for correctly uploading the record into the database.

Example:

DEFINE ENTITY
  KEY    NAME VARCHAR2(30)
  BASE   DEFINE VARCHAR2(32000)
  BASE   DOWNLOAD VARCHAR2(32000)
  BASE   UPLOAD VARCHAR2(32000)
END ENTITY
BEGIN ENTITY FND_APPLICATION_TL
  #
  # DEFINE record specifies structure of the data
  # records
  #
  DEFINE = "\n    DEFINE FND_APPLICATION_TL \n    KEY SHORT_NAME VARCHAR2(8) \n    TRANS NAME VARCHAR2(80) \n    TRANS DESCRIPTION VARCHAR2(240) \n    END FND_APPLICATION_TL"
  #
  # DOWNLOAD – statement to select downloaded data
  # select columns must be in same order as DEFINE
  # attributes
  #
  DOWNLOAD = "\n    select APPLICATION_SHORT_NAME, \n      APPLICATION_NAME, \n      DESCRIPTION \n    from  FND_APPLICATION_VL \n    where  APPLICATION_SHORT_NAME like '&APPSNAME'
  #
  # UPLOAD – statement to upload data into database
  # bind names must match DEFINE attribute names
  #
  UPLOAD = "\n    update FND_APPLICATION_TL \n    set  APPLICATION_NAME = :NAME, \n      DESCRIPTION = :DESCRIPTION, \n      SOURCE_LANG = userenv('LANG') \n    where  APPLICATION_ID = (select APPLICATION_ID \n      from FND_APPLICATION \n      where APPLICATION_SHORT_NAME = :SHORT_NAME) \n      and  userenv('LANG') in (language,source_lang)"
END ENTITY

Data File
As a continuation of the above example, the data file produced from a download of the above config file would look like:

# $Header$
LANGUAGE = "US"

DEFINE FND_APPLICATION_TL
  KEY SHORT_NAME VARCHAR2(8)
  TRANS NAME VARCHAR2(80)
  TRANS DESCRIPTION VARCHAR2(240)
END FND_APPLICATION_TL

BEGIN FND_APPLICATION_TL FND
  NAME = "Application Object Library"
  DESCRIPTION = "Your foundation for excellence"
END FND_APPLICATION_TL
Using the Navigator’s Processes Region

The Processes region of the Navigator presents specific business processes or tasks as diagrams that help you manage your work load. You can use these diagrams to open the forms related to the task and track your progress as you complete the various steps in the task.

Each time you begin a business process you create an “instance” of the process. You can create as many instances as you require. Each instance maintains its own version of the diagram identified by a name you assign. As you complete a form or “step” within your task you can save the data and update your diagram to indicate that this step is complete. When you open subsequent forms the information you entered in the previous step is used to query the data for the next step.

You are not required to complete a task before closing the process instance. A process instance can be closed for later completion or you can choose to end the instance before completion. Ending a process instance does not change or modify any data you have entered.

Creating and Opening a Process

Upon entering the Processes Region the processes assigned to your current responsibility are displayed in a list. To use a process you create an “instance” of the process and enter a name for the instance. This instance will remain “active” until you complete or cancel the process. Active instances are listed in the Navigator below the process from which it was derived. Instances are only available to the user who created them.

Creating a new instance

1. Select the process for which you wish to create an instance.
2. Choose Launch.
3. Enter the name for the new instance. This name appears in the Navigator Processes list.

Open an existing process instance

1. Single click on the process instance you want to open in the Navigator Processes list.

The Navigator continues to display the current process instance until you select another.
Working in a Process Instance

The process instance displays a diagram of your task broken into various steps. The diagram displays these steps as icons within the diagram. The active step or steps are indicated by green boxes drawn around the steps icon. There may be more than one active step if your process contains multiple paths.

The diagram enables you to view a brief description of each step or open the form associated with a step.

► Opening a form

Click once on any icon within the processes to display a brief description of that step.

Double-click on an icon to open the related Oracle Application form.

**Note:** You can open a step in the process instance, regardless of whether it is an active step. When opening a non-active step the system warns you that when you complete the step you cannot use the Process Step Completed option from the action menu and the process instance diagram will not indicate that the step is complete.

**Attention:** Function Security is enabled through the Processes region of the Navigator. If your current responsibility does not have access to the form, you cannot open the form.

► Completing a Step

When a step is based on a transaction updated through an Applications Form there are two ways you can complete the step:

- You can select the Process Step Completed from the Action menu, or
- Return to the Process Navigator and with the completed step highlighted choose the Complete button.

Use the second method for any step that is not based on completing a transaction based on an Applications Form.

► Ending a Process Instance

A process instance may be terminated at any time during the process and not affect any data you have entered. A process instance is automatically terminated when the last step in the process is complete. The system removes the process instance from the process navigator.
list the next time you log in. You may also choose to terminate a process instance before all of the steps are complete. To do this:

1. Select the process instance to be terminated.
2. Choose the Abort button.